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1. Introduction 

 

1.1 Preface 

 

Thank you very much for purchasing the Playon!DVR
HD

. We hope you will enjoy using it as a 

great home entertainment partner. This product has the following functionality. 

A/V Output 

• HDMI V1.3 for high-definition video and digital audio 

• Composite & component video and stereo audio for analog audio-visual connection 

• S/PDIF coaxial & optical interface for high-fidelity digital audio 

• Adjustable video output resolution (NTSC, PAL, 480p, 576p, 720p, 1080i, 1080p) 

Multimedia Playback 

• Supports major audio, video and image file formats (1080p HD video decoding) 

• Movie format: AVI/MKV/TS/TP/TRP/M2TS/MPG/MP4/M4V/MOV/VOB/ISO/IFO/DAT/ 

WMV/ASF/RM/RMVB/FLV  

• Music format: MP3/OGG/WMA/WAV/AAC/FLAC 

• Photo format: HD JPEG/BMP/GIF/TIF/PNG 

• Photo slide show with background music 

DVB-T Digital TV Tuner 

• Supports Digital Video Broadcasting Terrestrial (DVB-T) TV reception 

• Supports dual-tuner, allowing to watch different program while recording another 

• Supports Electronic Program Guide (EPG), Teletext and subtitle 

• Supports loop-out DVB-T signal received from aerial. 

Video Recording 

• Supports one button recording and scheduled recording, can easily record programs from 

DVB-T, DVD player, DV, etc., and saves as MPEG-2 (.mpg, or .ts) format;  

• Supports time-shifting function 
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Network Feature 

• A/V streaming/transmission via Ethernet (10M/100M) & Wi-Fi (802.11b/g/n, optional) 

• File sharing via Samba server 

• A/V streaming via UPnP Media Server 

• BitTorrent download (controlled and managed via web server) 

• Internet Radio (SHOUTcast) 

File Copy 

• Supports copying & moving files among Card, USB, HDD, and Network 

eSATA / USB 2.0 Support 

• eSATA host port (for eSATA storage devices) 

• USB 2.0 device port (for PC connection) 

• USB 2.0 host port x 2 (for USB storage devices) 

 

Note: All the information contained in this manual was correct at the time of publication. 

However, as our engineers are always updating and improving the product, your device’s 

software may have a slightly different appearance or modified functionality than presented in 

this manual. 

 

1.2 Packaging List 

 

Part Quantity 

AC Ryan Playon!DVR
HD

 1 

A/V cable 2 

Y/Pb/Pr cable 1 

USB cable 1 

Remote Control 1 

Remote Control Battery 2 

AC/DC adaptor 1 

AC/DC adaptor Power Cord 1 

Digital Antenna 1 

User Manual (printed) 1 

AC Ryan HDMI cable 1 

Playon! Wireless-N USB adaptor 1 (optional) 

 

Note: 

The actual contents in the package may be different from the packaging list in this manual. 
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1.3 Cautions 

 

The Playon!DVR
HD

 design and manufacture has your safety in mind. To safely and effectively 

use this product, please read the following before usage. 

1.3.1 Usage Cautions 

User should not modify this product. If commercial hard disk is being used, the environmental 

temperature should be within +5℃ ~ +35℃. 

1.3.2 Power 

The product’s power voltage: DC 12V. 

When using this product, please connect the supplied AC adapter to the product’s power jack. 

When placing the power adapter cable, please make sure it is not damaged or subjected to 

pressure. To reduce the risk of electrical shock, unplug the power adapter first before cleaning 

it. Never connect the power adapter to the product in a humid or dusty area. Do not replace the 

power adapter’s cable or connector by yourself. 

1.3.3 Radio Interference  

- If not properly shielded, almost all electronic devices will get radio interference. Under some 

conditions, your player might be subjected to radio interference. 

- The design of this player has followed the FCC/CE standard, and has adhered to the 

following rules: 

(1) This product may not cause harmful interference; 

(2) This product could accept some interference received including interferences that may 

cause undesired operation. 

1.3.4 Repair 

If the product is defective, you should take it to an authorized repair center and let the 

specialists do the repair. Never repair the product by yourself or you might risk damaging it or 

endangering yourself and losing your data. 

1.3.5 Disposing of the Product 

When you dispose the product, be sure to dispose it appropriately. Some countries may 

regulate disposal of electrical device, please consult with your local authority. 
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1.3.6 Hard Disk Cautions 

This product uses an internal hard disk for data storage and in normal cases, format or repair 

is not required. You should carefully read the < Frequently Asked Questions > chapter, and 

check our website for latest information before formatting the hard disk. 

 

- Physical impact may create bad sectors in the hard disk, you can use CHKDSK to diagnose 

and fix the problem. 

 

- All data stored in the hard disk may be lost due to physical impact, electrical shock, power 

lost, formatting etc. We advise that you backup your data periodically. 

- It is advisable to run disk defragment after a long period of usage. 

- Regularly backup your data in the hard disk so that it can be recovered in the event of data 

corruption or loss. Our company holds no responsibility for loss of data stored in the hard disk. 

1.3.7 Others 

When using this product, please do not let it come into contact with water or other liquid. If 

water is accidentally spilled on the product, please use a dry cloth to absorb the spillage. 

Electronic products are vulnerable during operation, please avoid shaking or hitting it, and do 

not press the buttons too hard. 

� Do not let the product come into contact with water or other liquid. 

� Do not disassemble the product, repair or modify the design of the product, any damage 

done will not be warranted under our service/repair policy. 

� Do not press the buttons of the product too hard. 

� Avoid hitting the product with hard objects, avoid shaking it, and stay away from magnetic 

objects and interference. 

� The product may malfunction under electrostatic discharge and strong electromagnetic 

interference. If it does, please unplug the power cable and the product will return to 

normal operation the next time it is powered on. 
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1.4 Connection 

1.4.1 Connecting the Power Adaptor 

(1) Follow the picture and connect the AC adaptor to the product DC IN jack; 

(2) Follow the picture and plug in the AC adaptor to the power outlet. 

 

1.4.2 Connecting to a PC 

(1) Make sure the product is powered on; 

(2) Plug in one end of the USB cable to the product USB device port; 

(3) Plug in the other end of the USB cable to your PC. 
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In this way, you can manage the content of the internal hard disk on your local PC. 

1.4.3 Connecting to an eSATA (External Serial ATA) storage device 

(1) Make sure the product is powered on; 

(2) Plug in one end of the eSATA cable to the product’s eSATA port; 

(3) Plug in the other end of the eSATA cable to the eSATA port of your storage device. 

 

In this way, you can browse the contents of the external storage device. 
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1.4.4 Connecting a USB storage device 

(1) Make sure the product is powered on; 

(2) Plug in your USB storage device to the USB host ports of the product. 

 

In this way, you can browse the contents of the USB storage device. 

1.4.5 Connecting a Memory Card 

(1) Follow the picture to insert the memory card to the card slot properly; 

(2) Insert the card by following the arrow pointer in the picture. 

 

In this way, you can browse the contents of the memory card. 
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1.4.6 Connecting to a TV 

1.4.6.1 A/V IN 

(1) Follow the picture and plug in the 3 color connector to the product’s A/V IN jack; 

(2) Follow the picture and plug in the 3 color connector to the A/V OUT jack of the source. 

 

In this way, you can record TV programs from the source TV/Set-Top Box. 

 

1.4.6.2 A/V OUT 

(1) Follow the picture and plug in the 3 color connector to the product’s A/V OUT jack; 

(2) Follow the picture and plug in the 3 color connector to the TV’s A/V IN jack. 

 

In this way, you can enjoy videos, music and photos on your TV. 
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1.4.6.3 Y/Pb/Pr Component OUT 

(1) Follow the picture and plug in the 3 color connector to the product’s Y/Pb/Pr jack; 

(2) Follow the picture and plug in the 3 color connector to the TV’s Y/Pb/Pr jack. 

Audio Connection while using Y/Pb/Pr Video out: 

First method: use the audio output from the A/V OUT jack;  

Second method: use the audio output from the S/PDIF Coaxial or Optical jack. 

 

In this way, you can enjoy videos, music and photos on your TV in higher quality. 

 

1.4.6.4 HDMI OUT 

(1) Follow the picture and plug one end of your HDMI cable to the product’s HDMI jack; 

(2) Follow the picture and plug the other end of your HDMI cable to the TV’s HDMI jack. 

Note: An AC Ryan HDMI cable is provided in the packaging. 
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In this way, you can have the highest quality video and audio via a single cable. 

 

1.4.6.5 ANT. / RF IN 

Follow the picture and plug a TV Aerial to the ANT. / RF IN socket; 

 

1.4.6.6 ANT. / RF OUT 

(1) Make sure the product is connected to the power supply;  

(2) Make sure a TV Aerial is connected to the ANT. / RF IN socket; 

(3) Follow the picture and plug a coaxial TV cable to the ANT. / RF OUT socket and plug the 

other end of this cable to a TV or receiver. 
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The product can loop out the DVB-T signal to other TV receiver device. In this way, you can 

watch the TV programs with another TV receiver while recording. 

1.4.7 Connecting to an Digital Amplifier 

(1) Follow the picture and plug in the RCA connector of your coaxial cable to the player’s 

S/PDIF Coaxial jack. Or if you use optical fiber, please plug in the Toslink connector on your 

optical fiber to the player’s S/PDIF Optical jack;  

(2) Follow the picture and plug in the other end of your coaxial cable or optical fiber to the 

digital audio device (digital amplifier or decoder). 

Note: The optical fiber and coaxial cables are not supplied. 
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In this way, you can enjoy powerful Dolby Digital, DTS, or MPEG audio. (Please refer to ‘3.2 

Changing Audio Settings’ for configuration)  

1.4.8888 Connecting to a LAN (Local Area Network) 

To connect to a LAN (Local Area Network) you require a cat5, cat5e or cat6 network cable (not 

supplied). 

(1) Connect one end of the network cable to the product’s RJ45 LAN socket; 

(2) Connect the other end of the network cable to a RJ45 LAN port on your router, switch, or 

hub devices. 
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1.4.9999 Connecting to a WLAN (Wireless Local Area Network) 

(1) Make sure the product is powered on; 

(2) Plug in the Playon! Wireless-N USB adaptor (ACR-WN10001) to the USB host port of the 

product.  

Note: The Playon! Wireless-N USB adaptor is an optional accessory sold separately. (Please 

refer to ‘3.5 Changing Network Settings’ for more details about wireless setup) 

 

1.5 Power On / Off 

Power On 

After connecting the DC IN jack and press the power button on the front panel, the product will 

soon enter the home screen, and the power indicator LED will turn blue. 

Power Off 

Press the power button on the front panel, the player will soon enter standby mode, and the 

power indicator LED will turn red. Then unplug the power cord to cut off the power supply. 

 

1.6 Menu Language 

 

The system language of this product can be set to English or other languages. Change the 

language you preferred in the setup menu, the selected language will take effect immediately. 
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1.7 HDD Format 

 

For users who wish to install a new SATA/SATA II HDD, please refer to the following 

procedures to format before usage. 

 

- Step 1: Select OK on the Warning page, press ENTER to confirm. 

 

Note: This page can be also accessed via Setup->System->HDD Format menu. 

 

- Step 2: Press the up / down button to adjust the capacity of time shift buffer. 

Press the left / right button to select Next, and the enter button to confirm. 
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- Step 3: Select Format, press ENTER, and then hard disk format will start. 

 

 

The formatting procedure will be completed within a few minutes. After completion the hard 

disk can now be used with the product. 

 

Note: HDD format will erase all data stored on the hard disk drive. Please take note and 

backup your data before proceeding! 
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2. About the Player 

                   

2.1 Remote Control 

 

All procedures in this manual can be carried out using the remote control buttons.  

See the following for details on each button and its function: 

 

 

1. STANDBY 2. TV SYSTEM  

3. BROWSER 4. Numeric buttons 

5. REPEAT 6. FR 

7. FF 8. PLAY / PAUSE  

9. HOME 10. Navigational buttons 

11. MENU 12. TIME SHIFT 

13. SLOW 14. ZOOM 

15. AUDIO 16. RED  

17. EPG(GREEN)  18. MUTE  

19. REC  20. COPY 

21. MUSIC  22. INFO  

23. VOL-/VOL+  24. PREV  

25. STOP  26. NEXT  

27. RETURN  28. ENTER 

29. SETUP 30. A-B 

31. GOTO 32. SUBTITLE 

33. ANGLE 34. BLUE  

35. 

TEXT(YELLOW) 
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No. Button Function 

1 STANDBY Press to enter standby mode or wake up. 

2 TV SYSTEM Press to switch between NTSC, PAL, 480P, 576P, 720P, 1080I, 

and 1080P. 

3 BROWSER Press to enter the browser menu. 

4 Numeric buttons Press to enter numeric input when changing settings. 

5 REPEAT Press to set repeat option: One, All, (and Shuffle). 

6 FR Press to fast rewind the current playback. Press repeatedly to 

select speeds. 

7 FF Press to fast forward the current playback. Press repeatedly to 

select speeds. 

8 PLAY/PAUSE Press to begin/pause the playback.  

9 HOME Press to enter the home screen. 

10 Navigational 

buttons 

Press the arrow buttons to select menu options, and the ENTER 

button to confirm. 

11 MENU Press to activate menus: 

--Press to rename and delete files in the browser menu.  

--Press to add shortcuts for network access in My_Shortcuts in 

NETWORK/NFS of the browser menu.  

Press to add/delete internet radio stations to favorite list. 

12 TIME SHIFT Press to activate the time shift function. Time shift function 

allows you to pause live TV and resume the program from the 

point you left it. While paused, the program is recorded to the 

internal HDD as long as the space is available. 

Time shift mode remains active until you press the stop button. 

13 SLOW Press to play back in slow motion. Press the PLAY button to 

resume regular playback. 

14 ZOOM Press to zoom the image (photo or video). 

15 AUDIO Press to select another audio track (if available). 

16 RED Press to select the files in Browser/File Copy menu. 

Press to add/delete scheduled recording in EPG menu. 

17 EPG(GREEN) Press to enter the Electronic Program Guide which displays an 

on-screen list of programs for the coming week when watching 

Digital Terrestrial TV. 

Press to add the selected files to the playlist under browser 



                                          19 / 83 

 

 

 

menu. 

18 MUTE Press to mute audio output, and press again to resume. 

19 REC Press to begin recording. 

Press repeatedly to set one touch recording (OTR) length (30 

MIN. / 60 MIN. / 90 MIN. / 120 MIN. / 180 MIN. / 240 MIN. / Off). 

20 COPY Press to enter the File Copy menu. 

21 MUSIC Press to start playing music in the music playlist. 

22 INFO Press to hide or display the information bar during playback.  

23 VOL-/VOL+ Press to decrease/increase the volume. 

24 PREV Press to view the previous file / page up. 

25 STOP Press to stop playback. 

26 NEXT Press to view the next file / page down. 

27 RETURN Press to return to the previous screen while navigating menus. 

28 ENTER Press to select options in menus. 

29 SETUP Press to enter the setup menu. 

30 A-B Press to set the beginning and end points of a section to repeat. 

31 GOTO Press to jump to a specific point on a title. Specify the point 

using Title, Chapter and Time. 

32 SUBTITLE Press to set subtitle options. 

33 ANGLE Press to change the view angle during DVD (with multi-angle) 

playback.  

34 BLUE Press to activate sort function in channel set in TV setup menu. 

35 TEXT(YELLOW) Press to open Teletext OSD if it is available in the broadcasted 

stream of Digital Terrestrial TV. 
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2.2 Front Panel 

 
1. Up button 2. VFD Screen 

3. Down button 

5. Right button 

7. Return button 

9. Power button & indicator 

4. Left button 

6. Enter button 

8. Menu button 

10. Infrared receiver window 

 

2.3 Rear Panel    

 

1. RJ45 LAN socket 2. S/PDIF OPTICAL jack  

3. S/PDIF COAXIAL jack 4. HDMI jack  

5. Y/Pb/Pr OUT jack  6. A/V OUT jack 

7. A/V DC IN jack 8. DC IN jack 

9. ANT. / RF OUT socket 10. ANT. / RF IN socket 

11. eSATA port 
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2.4 Side Panel 

 

 

1. Memory Card slot 2. USB host port (A-Type) x 2 

3. USB device port (B-Type)  

 

3. Setup Menu 

 

The Setup menu allows you to personalize and configure the preferences for your player. 

 

To select a Setup option: 

 

- Select the Setup icon on the home screen, or press the SETUP button on the remote 

control. 

   

- Use the LEFT/RIGHT navigational buttons to select an option, and then press ENTER. 

 

There are seven Setup options, including TV, Audio, Video, REC, Network, System, and 

Misc. Use the UP/DOWN navigational buttons to select a menu. Press ENTER to confirm. 

Press RETURN to cancel and display the previous menu screen.  
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3.1 Changing TV Settings 

 

Press the left / right button on the remote control to select the TV tab from the menu bar. 

TV Region 

- Select to set the region for Digital Terrestrial TV, choose Others if your region is not listed. 

Channel Scan 

- Select to scan for available Digital Terrestrial TV channels 

AUTO SCAN 

- In AUTO SCAN mode, the system will automatically scan for available DVB-T TV 

channels. 

MANUAL SCAN 

- In MANUAL SCAN mode, you can select the CH name, Bandwidth, and Input Frequency. 

Use the navigational and numerical buttons on the remote control to select or input. Press 

the enter button to confirm. 

Channel Set 

- Select to edit channel information. 

 

In this menu, you can edit the Name, and sequence for the DVB-T TV channels. Use the 

navigational buttons to select and modify the settings, and press the enter button to confirm. 

You can also press the BLUE button to select Sort. 
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3.2 Changing Audio Settings 

 

Use this menu to configure audio settings. 

 

Night Mode 

- Choose between Off / On / Comfort. If the option is turned on, the volume will be 

automatically decreased at high levels to make listening more comfortable at night. 

HDMI Output 

- Choose between RAW / LPCM DUAL CH / LPCM MULTI CH. In raw mode, Dolby Digital, 

DTS, or MPEG audio can be pass-through to the HDMI TV or Digital amplifier. 

SPDIF Output 

- Choose between RAW / LPCM DUAL CH. In raw mode, Dolby Digital, DTS, or MPEG 

audio can be pass-through to the Digital amplifier. 
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3.3 Changing Video Settings 

 

Use this menu to configure video settings. 

 

Aspect Ratio 

- Pan Scan 4:3: Display a wide picture on the entire screen and cuts off the redundant 

portions. Select when a standard 4:3 TV is connected. 

- Letter Box 4:3: Display a wide picture with two black borders at the top and bottom 

portions of a 4:3 screen. Select when a standard 4:3 TV is connected. 

16:9/16:10: Select when a widescreen 16:9/16:10 display is connected. 

Brightness 

- Adjust the level of brightness. 

Contrast 

- Adjust the level of contrast. 

Hue 

- Adjust the level of hue. 

Saturation 

- Adjust the level of saturation. 

Video System 

- Select to adjust video output resolution: NTSC / PAL / 480P / 576P / 720P 50HZ / 720P 

60HZ / 1080I 50HZ / 1080I 60HZ / 1080P 50HZ / 1080P 60HZ.  
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1080P 24HZ 

- Choose this option to enable or disable 1080P 24HZ support. A TV set with 1080P 24HZ 

(24P) mode is needed. 

Screen Size 

- Adjust the size of the image when playing movie. Press Left/Right button to 

decrease/increase the width of the image, press Up/Down to increase/decrease the height 

of the image. 

 

3.4 Changing Record Settings 

Quality 

- Select to set the default recording quality setting. 

 

Press the up / down button to select the recording quality you preferred. The higher the 

recording quality, the more storage space it will consume. This recording quality setting is only 

applicable to AV-IN recording. 

Permanent Timeshift 

- Select to set Timeshift mode. 

 

Press the up / down button to select On/Off. Press the enter button to confirm. If On, the time 

shift will start automatically while in Video-In mode. 

REC Device 

- Select to choose the device for your recording. 

 

Press the up / down button to select HDD, eSATA HDD, USB or card, Press the enter button 

to confirm. 
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3.5 Changing Network Settings 

 

Use this menu to configure Ethernet and WLAN (Wireless Local Area Network) settings. 

 

Wired LAN Setup 

- DHCP IP (AUTO) 

Select to obtain IP address automatically.  

- FIX IP (MANUAL) 

Select to manually input the IP Address, Subnet Mask, Default Gateway, and DNS Server 

IP Address.  

Wireless Setup 

- Selecting a connection profile 

 

This player can store up to three wireless network connections. Press ENTER to go to 

next step, press RETURN to cancel, and press PLAY to connect. 
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- Get Connection Mode 

 

Choose between Infrastructure (AP), Peer to Peer (Ad Hoc) or WPS(AP). Press ENTER 

to go to next step, and press RETURN to cancel. 

 

- Infrastructure (AP) 

Infrastructure mode is used to connect to a wired/wireless router or an access point. 

 

Get SSID Name 

 

Press ENTER to go to next step, press RETURN to cancel, or press RED to refresh the 

SSID list. 

Note: In the Security list, WEP (Wired Equivalent Privacy) and WPA (Wi-Fi Protected 

Access) means the network is encrypted, i.e. an encryption key is needed to access the 

network. NONE means it is an open system network. 
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Input WEP / WPA Key 

 

Encryption keys can be entered via the on-screen virtual keyboard. Press the navigational 

buttons to select, ENTER to input, CAPS to switch between uppercase and lowercase, <- 

to delete a character, -> to insert a space, shift to make more symbols available, and OK 

to confirm.  

 

Test connection 

 

The testing process may take a while to complete. If the test is ok, the network information 

(Profile Name, IP address, Subnet Mask, Gateway, etc.) will be displayed on the screen. 

 

- Peer to Peer (Ad Hoc) 

Peer to Peer mode, which is also called Ad Hoc mode or computer-to-computer mode, is 

used to connect networked clients directly without the need for a router or access point. 
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    Ad-Hoc Setup 

 

Press ENTER to go to next step, press RETURN to cancel, and press PLAY to connect. 

 

- WPS (AP) 

WPS, Wi-Fi Protected Setup, is used to connect a wireless router directly, without 

searching SSID and inputting password. In this mode, you just need to configure the 

parameters of your router which support WPS function. There are two modes for you to 

select, PBC mode and PIN mode.  

 

 

PBC 

 

First press the WPS button on the router or select the button mode in the configuration menu 

of the router, then select the PBC mode, the connection process may take a while to complete. 

 

PIN 

 

Input the pin code when you configure your router, and then select the PIN mode, the 

connection process may take a while to complete. 
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PPPoE Setup 

- Input the ADSL login username and password in this menu, the system will obtain an IP 

address automatically from the server based on PPPoE protocol. 

 

 

Login Control 

- Select to turn on / off password protect for the Web server (Neighbor Web).  

BitTorrent and SAMBA 

- Select to turn on / off BitTorrent download, NAS and Web server services. 

Host Name 

- Select to key in your desired host name to be seen in your network. 

Remote Conrol 

- Select to turn on / off remote control services. Please refer to ’4.11 Remote Control’ for 

more details on this unique feature of this product. 

 

FTP 

- Select to turn on / off FTP services and to configure your desired login User Name and 

Password. Please refer to ’4.13 FTP Server’ for more details on this unique feature of this 

product. 
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3.6 Changing System Settings 

 

Use this menu to configure system settings. 

 

Menu Language 

- Select to choose the OSD (On-Screen Display) language. 

Text Encoding 

- Select to set the text encoding option (subtitle display). 

System Update 

- Select Extension Package Upgrade to update extension files for BT download and 

SAMBA services. 

- Select system upgrade to update the firmware via a USB flash drive.  

1) Copy ‘install.img’ to the root directory of a USB flash drive, and connect it to the USB 

host port of the product. 

2) Press ENTER to confirm. 

Time 

- Select to set the system time.  
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Press the up / down button to select from Manual and Auto (via TV). Press the enter button to 

confirm. 

 

Manual 

 

Press the left / right button to select each field and the up / down button to adjust each setting. 

Numeric buttons are available here. Press the enter button to confirm. 

Parental Control 

- Select to set the TV parental control options. 

 

A password will be needed for the modification. The default password is ‘0000’. Press the 

numerical buttons to input, and the enter button to confirm. 

 

Lock system 

 

Press the up / down button to turn on or off the parental system. Press the enter button to 

confirm. 

Region 

Press the up / down button to select the region. Press the enter button to confirm. 
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Password 

Press the numerical buttons to input and change the password. Press the enter button to 

confirm. 

 

Block unrated TV 

Press the up / down button to turn on or off. Press the enter button to confirm. 

 

TV Rating 

Press the navigational buttons to select. Press the enter button to confirm, and the back 

button to exit. 

DVD Auto-Play 

- Select to turn on/off to auto play a DVD disc from an external USB DVD optical drive. 

Angle Mark 

- Select to display or hide the angle mark during DVD playback. 

HDD Format 

- Select to format the internal HDD. 

Note: Please take note that all data on the hard disk will be erased after formatting. 

System Info 

- Select to view system information (firmware version, HDD info, Mac address, etc.) 

Restore Default 

- Select to restore factory defaults. 

 

3.7 Miscellaneous 

 

Use this menu to adjust miscellaneous settings. 
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Resume Play 

- Select to turn on / off resume playback (auto-bookmarking) feature for videos.  

Slide Show Timing 

- Select to set the interval time for photo slide show. 

Transition Effect 

- Select to set the transition effect for photo slide show. 

Ken Burns 

- Apply PAN-Scan effects during Photo playback. 

Background Music 

- Select to set the background music options while viewing pictures: Off / Folder / Playlist. 

Seamless Playback 

- Uninterrupted playback of video files(.ts , .m2ts)  

(naming of the files should be for example, “abc01.ts” and “abc02.ts”, etc) 

Screen Saver 

- Select to set the idle duration for screen saver to appear. 

Movie Preview 

- Select to turn on / off movie preview in the browser menu. 



                                          35 / 83 

 

 

 

Subtitle on-off 

- Select to turn on / off subtitle by default. 

 

4. Main Functions 

 

4.1 Digital TV  

 

In this menu, you can watch and record Digital Terrestrial TV programs, or activate the time 

shift function. To view DVB-T TV programs, select the Digital TV menu at the home menu.  

The following are some functional buttons on the remote control, available when watching 

Digital TV programs. 

Name Function 

Enter Press to view the program list menu. 

up / down Press to switch channels. (Channels that are currently in recording are 

locked.) 

Numeric buttons Press to input channel numbers. Press the enter button to confirm. 

REC Press to start recording the current TV program. 

Time Shift Press to activate the time shift function. 

Subtitle Press to activate the subtitle list menu if available. 

EPG Press to activate the EPG menu if available. 

TEXT Press to activate the Teletext menu if available. 

Zoom Press to zoom out the image. 

4.1.1 Watching DVB-T Programs 

Program List Menu 

Press the enter button while watching DVB-T TV programs, and the program list menu where 

you can see the program number and name will be displayed. 
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All the TV and Radio programs will be listed on this list. Press the up / down button to select 

channels, and press the enter button to confirm. Press the prev / next button to page up or 

down. 

Info Bar 

While switching channels by the up / down button, an info bar will be displayed to show the 

channel information. 

 

There’re 4 strings displayed on the bar. Taking the info bar in the above photo for example: 

N/A – Stands for TV rating; 

ENG – Stands for the voice language; 

SS – Stands for subtitle; 

TT – Stands for Teletext; 

480 – Stands for resolution (SD - Standard Definition, HD – High Definition). 

When the string looks concave, the option will be available. 

Electronic Programming Guide 

Press the EPG button while watching DVB-T TV programs, the Electronic Programming Guide 

will be displayed. 
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Press the prev / next button to change channels. Press the left / right button to change date. 

Press the up / down button to change program. Press the RED button to add / delete 

scheduled recording. 

Teletext Menu 

If the broadcasted stream supports Teletext, press the TEXT button to enter the Teletext menu. 

 

 

Press the navigational and numeric buttons to view the content in the Teletext menu. 

Subtitle List Menu 

Press the subtitle button when watching DVB-T TV programs, the Subtitle List menu will be 

displayed.  
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Press the up / down button to select the subtitle, and press the enter button to confirm. 

4.1.2 DVB-T Program Recording 

Press REC button to start the recording, recording files are automatically stored in a folder 

named REC by default. 

  

 

This product allows you to watch a different channel while another one is in recording. When a 

recording is in place, press the ENTER button to get the program list, and then use UP/DOWN 

button to select the channel to watch. 

4.1.3 Time Shifting  

Time shift function allows you to pause live TV and resume it from the point where you left off. 

While paused, the program is being recorded to the internal HDD as long as storage space is 

available. Press the TIME SHIFT button to active time shift function. Press PLAY button to 

resume the program. Time shift mode remains active until you press the STOP button.  
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4.2 AV- IN  

 

In this menu, you can watch and record audio-visual signal from the A/V IN jack on the rear 

connections of the product. Time-shifting is also possible for AV-IN mode. 

 

Select the AV-IN menu on the home menu. 

The following are some functional buttons on the remote control available in AV IN mode. 

Name Function 

Record Press to start recording the current TV program. 

Time Shift Press to activate the time shift function. 

Zoom Press to zoom out the image. 

 

4.3 Schedule Recording 

 

The Schedule Recording menu allows you to create, edit and delete recording schedules and 

view all schedule status and history. Select the Schedule Recording menu on the home 

menu. 

Create a New Schedule 

Press the left / right button on the remote control to select the Edit tab from the menu bar. 

Select Add a New Schedule and press the enter button. The schedule setting screen will 

appear. 
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Use the left / right button on the remote control to move between fields and press the up / 

down button to adjust each setting. 

 

Source Select the video source or TV channels for the recording. 

Start Time Enter the date and time of the recording. 

Length Enter the length of the recording. 

Repeat Select how often you want the schedule to record. Choose from 

Once, Everyday, Mon-Fri, Mon-Sat or an individual day of the week. 

Quality Select the recording quality. Choose from HQ, SLP, EP, LP and SP. 

The higher the quality, the more space is required on the hard drive. See HDD 

Free Space on the top-left of the screen for details of the duration you can 

record for choosing different quality setting. 

Preview This small preview window will show the current program of the selected 

channel. 

Edit Schedule 

Press the left / right button on the remote control to select the Edit tab from the menu bar. 

 

 

Select the schedule you want to edit from the list and press the enter button. The schedule 

setting screen will appear . Modify the schedule as described in ‘Create a New Schedule’. 
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Delete Schedule 

Press the left / right button on the remote control to select the Delete tab from the menu bar. 

Select the schedule you want to delete and press the enter button. A confirmation message 

will appear. 

 

Select CANCEL, Delete the selected schedule, or Delete all schedules. Press the enter 

button to confirm. 

 

View Schedule Status 

Press the left / right button on the remote control to select the Status tab from the menu bar. 

The schedule list will be displayed. Select a schedule and press the enter button. 

 

Select Enable the selected schedule or Pause the selected schedule. Press the enter 

button to confirm. 
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Viewing Recording History 

Press the left / right button on the remote control to select the History tab from the menu bar. 

 

From here you can view the complete history of all recordings that were previously set. 

 

 

4.4 Browser 

 

The browser menu allows you to browse and play media files stored on Removable Devices 

(USB, Card), HDD, Network, UPnP-server, and Playlist. Select Browser menu from the home 

menu, or press the BROWSER button on the remote control. 

 

The following buttons can be used while navigating the browser menu. 

Button Function 

UP / DOWN Move cursor up / down to select devices, folders, or files. 

LEFT / RIGHT Select filter options: All, Music, Photos, and Movies. 

PREV / NEXT Go to previous / next page. 

ENTER Enter or confirm the selected item. 

RED Select files under Browser -> HDD menu. 

GREEN Add the selected files to the playlist. 

RETURN Return to the previous menu. 
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4.4.1 Browsing All 

In this mode, all folders and supported contents (music, photos, and movies) will be displayed. 

 

Note: 

• Please refer to chapter ‘7.1 Specifications‘for more about the supported content formats. 

• Muisc tracks might not be able to played continously under All filter, please switch to the  

Music filter instead. 

 

4.4.2 Browsing Music 

In this mode, all folders and supported audio files in current directory will be displayed.  

 

The following buttons can be used to control music playback. 

Button Function 

PLAY/PAUSE Begin/pause playback. 

FR / FF Fast rewind or fast forward. Press repeatedly to select the speed. 

REPEAT Set repeat options: One, All, (and Shuffle). 

INFO Hide or display the information bar during playback. 

STOP Stop playback. 
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4.4.3 Browsing Photos 

In this mode, all folders and supported image files in current directory will be displayed.  

  

The following buttons can be used to control photo playback. 

Button Function 

PLAY Begin playback. 

PREV / NEXT View the previous or next photo. 

LEFT / RIGHT Rotate photo. 

REPEAT Set repeat options: One, All, (and Shuffle). 

ZOOM  Zoom the image. 

INFO Hide or display the information bar during playback. 

STOP Stop playback. 

 

You can view photos in slide show mode with background music. When it is enabled, the slide 

show starts automatically once you press PLAY button. (Please refer to Slide Show Timing, 

Transition Effect, and Background Music in chapter ‘3.7 Miscellaneous’ for more details) 

 

4.4.4 Browsing Movies 

In this mode, all folders and supported video files in current directory will be displayed.  
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The following buttons can be used to control video playback. 

Button Function 

PLAY/PAUSE Begin/pause playback. 

SLOW Play video in slow motion. Press repeatedly to select the speed. 

FR / FF Fast rewind or fast forward. Press repeatedly to select the speed. 

PREV / NEXT View the previous or next movie. 

REPEAT Set repeat options: One, All, Off. 

ZOOM  Zoom the image. 

INFO Hide or display the information bar during playback. 

GOTO Display playback search menu. 

A-B Set the beginning and end points of a section to repeat. 

ANGLE Change the view angle during DVD (with multi-angle) playback. 

MENU Return to the root menu during DVD playback. 

AUDIO Select an audio track while watching video or DVD with multiple 

audio tracks. 

SUBTITLE Set subtitle options. You can change text encoding and the 

size/color/offset of the subtitle here. 

STOP Stop playback. 

 

4.4.5 A/V Streaming via Network 

 

You can stream your media files shared on the home network. Please refer to ’3.4 Changing 

Network Settings’ for more details on network settings. 

There are two ways to locate media files shared on your local network in the Network menu. 

One is to browse through workgroup; the other way is to browse through ‘My_Shortcuts’. 
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4.4.5.1 Browsing though Workgroup 

 

You can choose the workgroup which your PC belongs to from the workgroup list, find your PC 

name, and press the ENTER button to confirm. Then you can select and play the shared 

media files that you are currently browsing. 

 

Note:  

• While browsing high definition video files (resolution up to 720p / 1080i / 1080p) via 

Ethernet or WLAN, the video might be buffering. It is normal due to the limit of network 

speed or signal strength.  

• Due to different network conditions, sometimes the workgroup might not be accessed or 

shown in the list. In this case, you will need to use ‘My_Shortcuts’ to browse shared files. 

 

4.4.5.2 Browsing though ‘My_Shortcuts’ 

 

You can also set ‘Specific File Server IP’ and access it from ‘My_Shortcuts’ in the menu.  

- Press the MENU button and a popup menu appears. 

 

- Select Add to open a popup menu where you can input Label, Net User ID, Net 

Password, Domain, Host Name, and Specific File Server IP. Select OK to confirm, 

Cancel to cancel, and Simple / Detail to switch between simple and advanced options. 
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- Select the shortcut you added and press the ENTER button to confirm. Then you can 

select and play the shared media files on the destination computer. 

 

 

4.4.6 A/V Streaming via UPnP-server 

A built-in UPnP (Universal Plug and Play) client has been integrated on the system, which 

enables the player to auto-detect UPnP Media Servers on the network to browse and stream 

media files from them. 

 

4.4.6.1 Installing UPnP Media Server on your PC 

 

There are a lot of free and commercial UPnP Media Server software, such as Windows Media 

Connect, Windows Media Player 11, XBMC Media Center (Linux/Mac/Windows), MediaTomb 

(Linux), etc. Please install one of them on your computer. In the following chapters, we will use 

Windows Media Player 11 on Microsoft Windows XP SP2 as an example. 
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4.4.6.2 Sharing Media on your PC 

 

The Media Sharing feature of Windows Media Player 11 lets you enjoy the contents of your 

Windows Media Player library from anywhere in your home. 

- Launch Windows Media Player 11, click Library -> Add Library -> Advanced Options to 

add or remove media files from the library. 

 

 

- Click Library -> Media Sharing, then you can allow or deny devices to access the media 

library. Click Allow to authorize your player. 

 

 

4.4.6.3 Streaming Media on your Player 

 

- Connect your player to the home network (LAN or WLAN). 

- Select Browser - > UPnP menu, then select the UPnP-server, and press ENTER. 
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- Then you can browse the media library shared by Windows Media Player 11. 

 

4.4.7 Browsing through NFS server 

This system enables you to browser the media files shared on NFS Server (Ethernet or WLAN). 

Please refer to ’3.3 Changing Network Settings’ for details about network settings. 

- Press the MENU button and a popup menu appear. You can then Add/Modify/Delete a 

NFS server’s shortcut. 
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- Select Add to open a popup menu where you can input the NFS Server’s IP and the 

desired folder destination. Select OK to confirm, Cancel to cancel. 

 

- Select the shortcut you have added and press the ENTER button to confirm. You can then 

select and play the shared media files on the NFS server. 

  

 

Note:  

• Make sure the product and your computer are on the same local area network and subnet. 

• Firewalls may prevent the product to communicate with your computer. Please open the 

ports manually and add your player to the ‘trusted’ list, or disable the firewall temporarily. 

 

4.4.8 Renaming / Deleting Files 

 

While navigating in the browser menu, you can press the MENU button to activate a popup 

menu where you can rename or delete files or folders.  
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Press the UP / DOWN buttons to select from Return, Rename, and Delete. And press ENTER 

to confirm. 

4.4.9 Managing the Playlist 

This player supports the playlist function, which allows you to add your favorite contents on 

local HDD to the playlists (All, Music, Photos, and Movies), and enjoy them at any time. 

 

4.4.9.1 Adding files to the playlist 

 

Select the favorite file you wish to add and press the RED button, the file will then be marked. 

Press the GREEN button to confirm, and an on-screen message as seen below will be 

displayed. Multiple selections are allowed. 

  

 

4.4.9.2 Browsing the playlist 

 

Press the UP / DOWN buttons to select Playlist in the browser menu. Press the LEFT / 

RIGHT buttons to select between All, Music, Photos, and Movies. And press the ENTER 

button to confirm. Then you will enter the playlist. 
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If you wish to delete a file from the playlist, press the RED button to select, and then press the 

GREEN button to confirm. 

 

 

4.5 Media Library 

 

Integrating with a powerful search engine, the library menu allows you to easily search and 

browse multimedia files stored on the internal HDD. To enter this menu, select the Media 

Library menu at the home menu. 

4.5.1 Music library 

Use the left / right button on the remote control to select the Music tab.  

 

Press the up / down button to select from Update, Search, All, Artist, Genre, and Album. And 

press the enter button to confirm. 
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Update 
Select to update and index all the music stored on the internal HDD to the 

library. 

Search Select to search for music files by their names. 

 

Use the navigational buttons to select, and press the enter button to 

confirm. Select OK and press the enter button, and then the files with 

matching keywords will be displayed on the screen. 

 

All Select to list all the music files in the library. 

 

 

Artist Select to search for music files by artist. 

 

Press the up / down button to select the artist, and press the enter button 

to confirm. 
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Genre Select to search for music files by genre. 

 

Press the up / down button to select the genre, and press the enter 

button to confirm. 

Album Select to search for music files by album. 

 

Press the up / down button to select the album, and press the enter 

button to confirm. 

Quick-Search 

 

You can also press the right button to turn on a Quick-Search bar while 

browsing music files in the library. 

 

Press the up / down button to select characters on the Quick-Search bar, 

and press the enter button to confirm. The music files with name starting 

with the specific characters will be displayed. Press the left button to 

delete characters, and press the back button to close the Quick-Search 

bar. 
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4.5.2 Photo Library 

 

Use the left / right button on the remote control to select the Photos tab.  

 

Press the up / down button to select from Update, Search, All, and Date. And press the enter 

button to confirm. 

Update 
Select to update and index all the photos stored on the internal HDD to 

the library. 

 

Search Select to search for photos by their names. 

 

Use the navigational buttons to select, and press the enter button to 

confirm. Select OK and press the enter button, and then the files with 

matching keywords will be displayed on the screen. 
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All Select to list all the photos in the library. 

 

 

Date Select to search for photos by date. 

 

Press the up / down button to select the date, and press the enter button 

to confirm. 

 

Quick-Search 

 

You can also press the right button to turn on a Quick-Search bar while 

previewing photos in the library. 

 

Press the up / down button to select characters on the Quick-Search 

bar, and press the enter button to confirm. Photos with name starting 

with the specific characters will be displayed. Press the left button to 

delete characters, and press the back button to close the Quick-Search 

bar. 
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4.5.3 Movie Library 

 

Use the left / right button on the remote control to select the Movies tab.  

 

Press the up / down button to select from Update, Search, All, Actor, Genre, and Year. And 

press the enter button to confirm. 

 

Update 
Select to update and index all the movies stored on the internal HDD to 

the library. 

 

Search Select to search for movies by their names. 

 

Use the navigational buttons to select, and press the enter button to 

confirm. Select OK and press the enter button, and then the files with 

matching keywords will be displayed on the screen. 
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All Select to list all the movies in the library. 

 

 

 

Actor Select to search for movies by actor. 

 

 

Press the up / down button to select the actor, and press the enter button 

to confirm. 

 

Genre Select to search for movies by genre. 

 

 

Press the up / down button to select the genre, and press the enter 

button to confirm. 
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Year Select to search for movies by year. 

 

Press the up / down button to select the year, and press the enter button 

to confirm. 

Quick-Search 

 

You can also press the right button to turn on a Quick-Search bar while 

previewing movies in the library. 

 

Press the up / down button to select characters on the Quick-Search bar, 

and press the enter button to confirm. Movies with name starting with the 

specific characters will be displayed. Press the left button to delete 

characters, and press the back button to close the Quick-Search bar. 

 

Note: 

In order to use the search function more efficiently, you are encouraged to use the following 

rules to name the movies stored on the internal HDD. 

 

Syntax: [Name][Actor][Genre][Year].extension 

 

Examples: [Enchanted][Amy Adams][Love][2007].avi, [The.Dark.Knight][Christian 

Bale][Action][2008].avi, etc. 
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4.6 Movie Jukebox 

 

 

 

(YetAnother)MovieJukebox is a command line tool, written in Java, which recursively scans 

your video library for video files (AVI, MKV, VIDEO_TS, BluRay, etc.) and analyzes these files 

in order to extract information like: year, language, subtitles, container, part, fps, audio and 

video codecs. Other movie and television information like, director, rating, etc. are collected 

using various plugins for online databases such as IMDb, TheMovieDB, TheTVDB, Allocine, 

FilmAffinity, FilmWeb, etc. 

 

MovieJukebox then generates the indexes that are compatible for displaying in the AC Ryan 

Playon! series media boxes. 

 

Getting Started 

1. Launch YAMJ for A.C.Ryan 

(Please download from www.acryan.com/downloads/YAMJ_Installer1.0.zip) 

 

Launch the program by double clicking on the icon on your desktop or from the Start Menu, 

A.C.Ryan MovieJukebox 

 

The program will prompt you to install Java runtime if it does not detect any Java 

installation in your system. 

 

Please select Yes to proceed with the installation of Java. 
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2. Running YAMJ for A.C.Ryan 

 

2.1 Select the directory of your stored movies in your product internal HDD, or on any 

external USB storage device or network attached storage (NAS) which you will use to 

run the MovieJukebox on the player. 

Note: Generating the necessary information to a network device may take a longer 

time than doing the same via USB. 

 

2.2 Press the Save button to save the directory information. Press Ok to close the dialog 

box. 
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2.3 Press Run/Update to start generating the Jukebox. An active internet connection is 

required to obtain the movie information. 

 

2.4 Press any key to close the command window after the generation is completed. 

 

3. Updating existing Jukebox 

You can update the existing Jukebox if you have add/remove movies to the previously 

saved directory. 

 

Launch Run or Update YAMJ by double clicking on the icon on your desktop or from the 

Start Menu, A.C.Ryan MovieJukebox 
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Running Movie Jukebox 

 

From the Home menu screen, enter the Movie Jukebox menu 

 

 

Go to the location of your Jukebox where it was generated with YAMJ for A.C.Ryan 

 

 

Example, if your Jukebox information is generated and stored on the internal hard disk of 

your product, choose this selection 
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Upon entering the location, the system will search and display all generated Jukebox 

information for loading (if you have more than one) 

 

 

A message box will ask if you want to update the selected Jukebox 

- Choose Yes if you are loading it for the first time or made any changes
#
 

- Choose No to continue loading
*
 

 

#: If you have add/remove any new contents to your current Jukebox, please generate 

again with Run or Update YAMJ and then select Yes to update and load with the new 

Jukebox information. Choosing Yes is also required for loading Jukebox for the first time. 

 

*: Updating the Jukebox for the first time may take a while depending on the location of 

your stored Jukebox and the amount of movies this Jukebox has. You can speed load the 

same Jukebox again the next time by selecting No. 
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Selecting Other – All from the category page will display all cover arts in the Jukebox in a 

thumbnail layout. You can also use the category page to sort and display your movies 

according to Genres, Title, Rating, Year, etc. 

 

 

Selecting any movie from the thumbnail will display the movie details as well as the movie 

synopsis, star rating, etc as generated by YAMJ for A.C.Ryan 

Press the Enter button on your remote control to start playing the movie. Enjoy. 

 

 

4.7 Torrents 

 

Turn on BitTorrent and SAMBA option in setup menu before using BitTorrent download function, 

and make sure the product is connected properly to a LAN or WLAN with Internet access. 

Select the Torrents icon at the home menu. You can see the status of torrents download 

progress and configure the BT download settings in this menu. Press LEFT/RIGHT button to 

enter into download menu or BT setup menu. 
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Adding a torrent  

Locate your torrent file in Browser menu,then press MENU button to add the torrent to start 

downloading. 

  

 

Download Menu 

After adding the BT torrent files, the download progress will be displayed in this menu.  

 

The following buttons can be used under this menu. 

Button Function 

UP / DOWN Move cursor up / down.  

MENU press to adjust the priority of the download task 

 

PAUSE Press to pause the download. 
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PLAY Press to resume download. 

STOP Press to stop the download. 

 

RETURN Return to the previous menu. 

 

BT setup Menu 

 

 

In the BT Setup menu, you can configure the following settings. Use UP/DOWN and ENTER 

to change the settings. 

- Set the maximum download rate. 

- Set the maximum upload rate. 

- Set the idle hours to start the next download automatically. 

- Set the seeding hours. 

- Set to delete the finished torrent files automatically. 

- Set the maximum number of simultaneous download tasks. 

 

4.8 Internet Feeds 

 

This feature is an add-on function. All contents and services under this feature are provided by 

third-party service providers, our company does not offer any contents and services of this 

feature and is not responsible for any contents and services provided under this feature. Our 

company is not responsible for any operational stability of the contents and services, for 

example, if you cannot access certain web site for video streaming or news broadcast, or the 
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content of a web site has been changed etc, are all responsibilities and controlled by the 

third-party service providers. If you find that these features are not operating correctly, please 

contact our customer service or visit our forum to obtain the relevant information. 

 

Note:  

• Make sure the product is connected properly to a LAN or WLAN with Internet access, 

please refer to ‘3.4 Changing Network Settings’ for more details. 

 

 

4.9 Internet Radio 

 

This product integrates the SHOUTcast free Internet Radio portal. Select the Internet Radio 

menu at the home menu. 

   

Note:  

• Make sure the product is connected properly to a LAN or WLAN with Internet access, 

please refer to ‘3.4 Changing Network Settings’ for more details; 

• When you enter the Internet Radio menu for the first time, it may take several seconds to 

load the stations from the portal. 

• For more information on SHOUTcast, please visit their website: www.shoutcast.com 

 

 

The following buttons can be used under this menu. 

Button Function 

UP / DOWN Move cursor up / down to select station, channel, and genre.  

PREV / NEXT Page up / down. 

ENTER Confirm and enter the selected menu. 

MENU Add / delete a station to / from Favorite while it is highlighted. 

PLAY Begin playback after a channel has been selected. 

STOP Stop playback. 

RETURN Return to the previous menu. 
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Station 

- All loaded stations will be listed under this menu.  

Genre 

- You can search for stations by genre (pop, rock, jazz, etc.) under this menu. 

Favorite 

- Your favorite stations can be kept under this menu. 

Search 

- You can search for stations with the on-screen virtual keyboard under this menu. 

 

 

4.10 File Copy  

 

Select the File Copy menu from the home menu or press the COPY button on the remote 

control, which allows you to copy files between Removable Devices (Card, USB), HDD, and 

Network. 

 

The following buttons can be used under the file copy menu. 

Button Function 

UP / DOWN Move cursor up / down to select devices, folders 

RIGHT Go to the next step. 

RED Select (or cancel) folders or files (The selected items will be 

marked). 

STOP Cancel all selections. 

ENTER Confirm the selected options. 
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Please refer to the following steps to copy / move files / folders between devices. 

- Step 1: Select the source device and enter to the directory of your source files. 

- Step 2: Select the files you want to copy/move. 

- Step 3: Select the destination device to copy/move the marked files. 

- Step 4: Select Copy or Move to proceed. 

 

 

4.11 Remote Control 

 

This product comes with a unique remote control feature that allows user to remotely access 

from the internet to operate the following functions on the product via a built-in HTTP server. 

 

• Remote Control 

Using the on-screen virtual remote control and use it like you would with the hand-held 

 

 
 

 

• Upload/download files 

You can view the status of your internal hard disk or the attached USB storage device 

from anywhere over the internet. 
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Clicking on an hyperlink of your file name to download, or use the Browse button to find 

the file you wish to transfer to the internal hard disk, and then click on Upload to being 

transferring. 

 

 

 

• BitTorrent management 

View and manage your BitTorrent tasks remotely over the internet. 
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• Schedule Recording 

If you have missed scheduling a recording before you leave the house, you can still have 

it done just by logging on over the internet! 

 

 

 

• View recording history status 

You can check on your past recording history over the internet, a thoughtful 

implementation for you to check on your recordings while you are away from home. 

 

 

 

HTTP Server configuration 

 

On your product, 

- Assign a manual Fixed IP address for the product, for example 192.168.0.9 when you 

connect to your router either via wired or wireless connection. 

- Assign the same subnet mask as your router, usually 255.255.255.0 and the gateway of 

your router (router’s local IP address, usually 192.168.xxx.xxx). Please refer to your 

router documentation on getting these information from your router. 

- Key in your router DNS IP address (primary or secondary) 
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On your router, 

- Configure HTTP Server within your router’s Virtual Server setting and key in the above IP 

address in example, 192.168.0.9 and change both the public and private port to 1024 

which is port 80 by default. 

- For your convenience, you can also choose to enable Dynamic DNS and sign up for a 

free DDNS domain at any of the website providing such free services. An example would 

be www.dyndns.com 

- At your router’s DDNS page, key in your host name and enter the same user name and 

password when you create a DDNS account. Please refer to your router documentation 

on getting these information from your router. 

 

To access via HTTP server from out of your local network, launch a web browser such as 

Internet Explorer and at the address bar, key in either 

 

- http://123.456.789.000:1024 where 123.456.789.000 is the WAN IP address of your 

router. Please refer to your router documentation on getting this information from your 

router. 

 

Or 

 

- Key in http://DDNS-HOST-NAME:1024, where DDNS-HOST-NAME is the host name 

which you have signed up for at your desired DDNS service provider. 

 

4.12 SAMBA Server and Client 

 

This player can be used either as a SAMBA Server or as a client.  

SAMBA Client 

- You can stream media files shared on the home network. Please refer to ’4.4.5 A/V 

Streaming via Network’ for more details. 

SAMBA Server 

- This product functions as a NAS (Network Attached Storage) device when it is attached to 

the home network via either Ethernet or WLAN. This feature allows users to store and 

retrieve large amounts of data from their own local network. 

- When the network connection is done correctly and ready for use, please turn on 

BitTorrent and Samba function in the setup menu in advance (refer to 3.5 Changing 

Network Settings for more details), and then type in: \\IP Address in the Run window 

(click Run in the start menu) or in the address bar of a web browser, for example Internet 

Explorer on your PC (if the IP address of the product is 192.168.0.9, please type in: 

\\192.168.0.9), and click OK or press the Enter button on the keyboard. 
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Under Windows Vista and Windows 7, please type in: \\192.168.0.9 at the search bar, then 

press the Enter button on the keyboard. 

 

 

 

You can then manage the files stored on the internal hard disk of the product. In this way, you 

can also playback and copy files via network between your PC and the internal hard disk of 

this product. 

 

 

4.13 FTP Server 

 

This product can also function as a FTP Server when it is attached to your home network via 

wired or wireless connection. 

FTP Sever Configuration 

- You can configure the username and password of the FTP Server. Please refer to ’3.5 

Network setup’ on doing so. 

 

On your product, 

- Assign a manual Fixed IP address for the product, for example 192.168.0.9 when you 

connect to your router either via wired or wireless connection. 

- Assign the same subnet mask as your router, usually 255.255.255.0 and the gateway of 

your router (router’s local IP address, usually 192.168.xxx.xxx). Please refer to your 

router documentation on getting these information from your router. 

- Key in your router DNS IP address (primary or secondary) 
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On your router, 

- Configure FTP Server within your router’s Virtual Server setting and key in the above IP 

address in example, 192.168.0.9 and leave both the public and private port to 21 which is 

by default for most routers. 

- For your convenience, you can also choose to enable Dynamic DNS and sign up for a 

free DDNS domain at any of the website providing such free services. An example would 

be www.dyndns.com 

- At your router’s DDNS page, key in your host name and enter the same user name and 

password when you create a DDNS account. Please refer to your router documentation 

on getting these information from your router. 

Accessing from a FTP program 

Using your favorite FTP application on your PC, an example would be ALFTP, which can be 

downloaded from http://www.altools.com/ALTools/ALFTP.aspx  

 

At the FTP program connection page, you can either connect using your router’s WAN IP 

address or via your DDNS host name. 

 

Be sure to start the FTP service with your User Name and Password as discussed at FTP, ’3.5 

Network setup’ 

 

 

FTP Address: Your router’s WAN IP address 

User ID:  The User Name which was set under FTP, ’3.5 Network setup’ 

   Password: The Password which was set under FTP, ’3.5 Network setup’ 
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FTP Address: Your DDNS host name 

User ID:  The User Name which was set under FTP, ’3.5 Network setup’ 

   Password: The Password which was set under FTP, ’3.5 Network setup’ 

 

 

After login is successful, you will be able to upload/download files via FTP Server. 

 

 

5. Upgrading the Firmware 

 

The firmware is the operating system (OS) installed and running on the product. Firmware 

upgrades can bring new features, improvements and bug fixes. 
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(1) Copy ‘install.img’ or extension files to the root directory of a USB flash drive, and connect it 

to any of the USB host port of the product. 

(2) Press and hold on to the power / standby button on the front panel of the product. 

(3) Plug the power cable into the DC IN jack, wait for about 5 seconds or more, and then 

release your finger on the power / standby button; 

 

Firmware installation will start shortly. There is another way for upgrading. Please refer to 

System Update and Extension Info in chapter ‘3.6 Changing System Settings’ for more 

details. 

 

6. Appendixes 

 

6.1 Specifications 

 

I/O INTERFACES SUPORTED: 

� 3.5’’ SATA/SATA II HDD 

� eSATA host port 

� USB 2.0 host port x 2 (compatible to USB 1.1) 

� Memory Card slot (supports SD/SDHC/MMC/MS/MS Pro) 

� USB 2.0 device port (connecting to PC) 

� Composite (CVBS) A/V IN jack 

� Composite (CVBS) A/V OUT jack  

� Component Y/Pb/Pr jack 

� ANT.RF IN/OUT socket 

� HDMI V1.3 interface 

� S/PDIF coaxial & optical jack 

� DC-IN 12V 

FILE SYSTEM SURPORTED: 

� Internal hard disk: NTFS 

� External storage: FAT/FAT32/NTFS/EXT3/HFS+ 

CONTENT FORMATS SUPPORTED: 

� AVI/MKV/TS/TP/TRP/M2TS/MPG/MP4/MOV/M4V/VOB/ISO/IFO/DAT/WMV/ASF/RM/ 

RMVB/FLV, resolution up to 720p/1080i/1080p 

� MP3/OGG/WMA/WAV/AAC/FLAC 

� HD JPEG/BMP/GIF/TIF/PNG 

VIDEO CODECS SURPORTED: 

� MPEG-1 

� HD MPEG-2 

� HD MPEG-4 SP/ASP/AVC (H.264) 
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� WMV9 (VC-1) 

� RealNetworks (RM/RMVB) 8/9/10, up to 720p 

AUDIO CODECS SURPORTED: 

� MP2/3, OGG Vorbis, WMA (DRM, and Advanced Profile not supported), PCM, LPCM, 

MS-ADPCM, LC-AAC, HE-AAC, COOK, RA-Lossless 

SUBTITLE FORMATS SURPORTED: 

� SRT, SMI, SSA, ASS, IDX/SUB, SUB 

NETWORK FEATURE 

� 10/100Mbps Auto-Negotiation Ethernet 

� 802.11b/g/n, up to 300Mbps (supported by optional Playon! Wireless-N USB adaptor) 

VIDEO RECORDING 

� Digital TV recording format: TS 

� AV IN recording format: MPG(MPEG2,MP2) 

 

Note: The specifications and design of this product are subject to change without notice. 

 

 

6.2 Frequently Asked Questions 

 

Question 1. When I try to disconnect the USB device, I keep on getting “The device 

‘Generic volume’ cannot be stopped right now. Try stopping the device again later.” 

message, what should I do?  

 

Answer:  

Close any program that might be accessing data on the player, including Windows® Explorer. 

If it does not work, close all programs and wait for another 20 seconds, then try the green 

arrow icon again. If it still does not work, you should shut down the player and disconnect the 

USB cable. 

 

Question 2. I find new file names and folder names that I never created before or they 

have strange gibberish names. 

 

Answer:  

Most likely, the player’s file allocation table (FAT) has been corrupted. This might be due to the 

player shutting down (due to low battery power) while reading or writing to your computer by 

the USB connection. Windows and Macintosh often write extra files to the hard disk such as 

finder.def or System volume info. These are normal and will not do any harm to the player. 
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Question 3. I used my player to transfer files back and forth between different 

computers. Will defragmenting the player hard disk do any harm to it? 

 

Answer:  

Defragmenting the player hard disk may be useful after having transferred many files to and 

from the player. It is never harmful to use the defragment on the player. Make sure no other 

programs are running while using the Windows® defragment utility. Make sure you have 

connected the player with the external power adapter during this procedure. 

 

Question 4. My files have disappeared from the player. 

 

Answer:  

Make sure that you browse your files via the correct browser mode which means correct 

filtered views such as Photos, Music, or Movies. 

 

Question 5. During power on, why does the TV will have a short flashing, blue screen or 

screensaver? 

 

Answer: 

This is normal, when the system initializes, it will setup the corresponding parameters so it can 

output the correct video signal to the TV, during the initializing time, the TV will receive 

incorrect signals or the signals will not be stable and will cause the TV screen to flash, some 

TV’s will treat this as no signal, and will display a blue screen or screensaver. 

 

Question 6. Why when I switch to Y/Pb/Pr 480p, 576p, 720p, 1080i, and 1080p, does the 

TV screen display an unwatchable picture? 

 

Answer: 

Please check if your TV supports Y/Pb/Pr 480p, 576p, 720p, 1080i, and 1080p output, if your 

TV does not support, please use the A/V signal display instead, press the TV SYSYEM button 

on the remote control, then switch the TV’s video input to NTSC or PAL. 

 

Question 7. Why is there no sound on movie or music playback when using Y/Pb/Pr 

component output? 

 

Answer: 

Y/Pb/Pr output is a video output only, and does not include sound signals. When using Y/Pb/Pr 

output, please plug the A/V OUT or the S/PDIF jack to output sound. 

 

 

 

 



                                          80 / 83 

 

 

 

Question 8. I cannot get SSID name, the screen always displays: ‘Can’t get any SSID!!’ 

 

Answer: 

When the WLAN USB Adapter is connected to the player, it needs some time to get initialized. 

Please wait for about 1~2 minutes and try refreshing the SSID list again.  

 

Question 9. I cannot see files shared on my computer via Browser->Network menu. 

 

Answer: 

Please check following items: 

1) Connect the player to network and obtain an IP address first; 

2) Please enable NetBIOS of TCP/IP on computer; 

3) Please check your PC’s firewall settings; 

4) Please enable your PC’s ‘Guest’ account; 

5) Please share the folders which you wish to browse on your PC, and make sure that 

‘Everyone’ or ‘Guest’ has the right to access. 

 

Question 10. I configured everything correctly, but still cannot get the wireless network 

or UPnP function to work. 

 

Answer: 

Are you using a firewall such as Norton Internet Security, McAfee Personal Firewall, Zone 

Alarm, etc. or even the built-in firewall of Windows XP? (Don’t forget that Service Pack 2 for 

Windows XP automatically upgrades your firewall and turn it on by default)  

 

If you have a firewall, it may need to be configured or have exceptions created to allow you to 

see and communicate with the player on the network. To test if your firewall is preventing 

network communication (including PING and access shared folders), try disabling it to see if 

you can connect. If you can connect with the firewall disabled, you may need to add the player 

to the ‘Trusted’ list or configure the firewall for local intranet access. Worst-case, disable your 

firewall long enough to use the player, then enable it again when done. 

 

Question 11. I am using the 802.11n Wi-Fi dongle with an 802.11n wireless router, why 

the speed is still 802.11g 54Mbps rather than 300Mbps? 

 

Answer: 

The IEEE 802.11n Draft standard prohibits using high throughput with WEP or TKIP as the 

unicast cipher. If you use these encryption methods (e.g. WEP, WPA-TKIP), your data rate will 

drop to 54 Mbps. You may contact the Access Point or router manufacturer to download the 

latest firmware, or try other encryption methods (WPA2-AES or WPA2-TKIP), or choose to 

configure an unsecured profile, but this option is not recommended. 
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Question 12. Where can I find .torrent files for BitTorrent download? 

 

Answer: 

A lot of torrent sites can be found on the Internet, such as The Pirate Bay, Isohunt.com, 

TorrentPortal.com, Mininova.org, etc. Please take care of the contents you’re downloading and 

their usage, which might cause copyright infringements and violate the local laws.    

 

Question 13. Why do some supported photo formats, cannot be shown in the photo 

function? 

 

Answer: 

In the JPEG format there are different modes. The player doesn’t support all the modes. So 

you have to change your photo format first as follow:  

(1) Use Photoshop to open the photo; 

(2) Choose ”File” then “save as” from the menu, as the picture on the left hand side shows, 

select the picture format as JPEG, input the file name and click the “save” icon;  

(3) After click on the “save” icon, a new window will appear as the picture on the right hand 

side shows, select “Baseline (standard)” or “Baseline optimized”;  

         
(4) Click the “OK” icon. 

 

Question14. Why couldn’t the player find the hard disc? 

 

Answer: 

Make sure the firmware is installed correctly, and no system partitions on the HDD were 

deleted. If hard disc failure occurs, please backup your data and reinstall the firmware. 
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Question15. Some functions like recording, time shift etc. do not work. What should I 

do? 

 

Answer: 

If you find some functions do not work properly on the player, please change system settings 

to the default (Refer to 3.6 for changing system settings).  

 

6.3 Copyrights and Trademarks 

 

Copyrights 

All rights reserved. No part of this manual may be reproduced, or transmitted in any form or 

by any means, whether by electronically or mechanically, without the express written 

permission from the copyright holder. 

Copyrighted materials, such as software, music files, or movies, are protected by local law, and 

may not be illegally copied or used without permission from the copyright owner.  

 

Trademarks 

Microsoft and Windows are registered trademarks of Microsoft Corporation. 

All other trademarks are property of their respective holders. 

  Manufactured under license under U.S. Patent #’s: 5,451,942; 5,956,674; 

5,974,380; 5,978,762; 6,487,535 & other U.S. and worldwide patents 

issued & pending. DTS and the Symbol are registered trademarks, & DTS 

2.0+ Digital Out and the DTS logos are trademarks of DTS, Inc. Product 

includes software. © DTS, Inc. All Rights Reserved. 

  Manufactured under license from Dolby Laboratories.  

Dolby and the double-D symbol are registered trademarks of Dolby 

Laboratories. 
 

 

6.4 Warranty 

 

What your warranty does not cover: 

-Acts of nature, such as fire, static discharge. 

-Damage from unauthorized repair, alteration or accident. 

-Damage from misuse or neglect. 

-A unit that has been modified or incorporated into other products or is used for institutional or 

other commercial purposes. 

-Loss of customer’s software, firmware, information, or memory data. 

-Improper handling or installation. 
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6.5 GPL Statement 

 

This product contains free software which is licensed under the GNU General Public License.  

After you purchase this product, you may procure, modify or distribute the source code of the 

GPL/LGPL software that is used in this product. 

 

To obtain a copy of our open source software, please contact our support center and we will 

provide you with a CD-ROM of the source code that is used, charging only the actual expense 

involved. However, please be noted that we cannot provide guarantee with the source code, 

and there is also no technical support for the source code from us. 

 


